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1. Introduccidén

SIMULINK es una toolbox especial de MATLAB que sirve para simular el
comportamiento de los sistemas dindmicos. Puede simular sistemas lineales y no
lineales, modelos en tiempo continuo y tiempo discreto y sistemas hibridos de todos los
anteriores. Es un entorno grafico en el cual el modelo a simular se construye clicando y
arrastrando los diferentes bloques que lo constituyen. Los modelos SIMULINK se
guardan en ficheros con extension * .mdl.

Con las nuevas versiones, SIMULINK ha ido ampliando sus librerias de bloques

(blocksets) y capacidades. En concreto, destaca el paquete STATEFLOW, que permite
la simulacion de maquinas de estados.

/ Stateflow \
/ Simulink \
/ Matlab \

Fig. 1. Jerarquia de Matlab, Simulink, Stateflow
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Otras blocksets de interés son, por ejemplo, las de comunicaciones (Communications
Blockset, CDMA Reference Blockset, RF Blockset) que incluyen bloques que simulan
estaciones de telefonia movil o dispositivos tales como los PLLs; las de aplicaciones
Blockset, Signal Processing Blockset, Video and Image
y las de soporte (Gauges Blockset).
efectos (ver, por ejemplo, las demos de SimMechanics o Virtual Reality Toolbox

especificas (Aerospace
Processing Blockset);

>>mech_conveyor_vr, >>mech_airbag_vr ...).

Hay muchas demos y

Ademas algunas toolboxes de MATLAB incorporan también blogques de SIMULINK.
Es el caso, por ejemplo, de la Control Systems Toolbox, Neural Network Toolbox, Fuzzy
Logic Toolbox, System ldentification Toolbox,... Finalmente, también existen librerias
de bloques que permiten interactuar con tarjetas de adquisicion de dados y DSPs: Real-
Time Workshop, Embedded Targets for Motorola and TI, XPC Target.

Teclear >>ver en la ventana de comandos de MATLAB para ver qué version de

SIMULINK y qué blocksets estan instaladas.

2. Simulink

2.1 Coémo iniciar Simulink

Para abrir la libreria de bloques SIMULINK puede hacerse escribiendo >>simulink en

la ventana de comandos de MATLAB, o bien clicando en el icono E de la barra de
menus de MATLAB.
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Fig. 2. Inicio de Simulink (en Matlab v6.1)
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Si ya tenemos algin modelo SIMULINK creado, modelol.mdl, basta hacer doble clic
en su nombre para que primero se abra MATLAB y a continuacién se abra la ventana
modelol que contiene a dicho modelo. O bien, si se tiene el MATLAB abierto, basta
con teclear >>modelol en la ventana de comandos.

Si vamos a crear un modelo nuevo hay que seleccionar File > New - Model 0 bien
clicar en el icono B de la libreria de SIMULINK.

2.2 Construccion de modelos

Ventana de modelo: Cada modelo (o0 submodelo) se construye en una ventana diferente.
Por ello, para construir un nuevo modelo hay que abrir una nueva ventana de modelo
untitled (ver Fig. 2) A partir de ahi, se trata de arrastrar los bloques que compondran
el modelo desde la libreria de SIMULINK a dicha ventana. Antes de empezar a trabajar
con SIMULINK, se sugiere echar un vistazo a las opciones de la barra de menus y la
barra de herramientas de la ventana de modelo.

Interconectar blogques: Las interconexiones entre bloques se realizan arrastrando el
raton entre los puertos de entrada y salida de dichos blogues. También es posible
seleccionar un bloque y, manteniendo la tecla <ctrl> presionada, clicar en el otro
blogue. Se puede poner texto en cualquier sitio (haciendo doble clic en el sitio
deseado), se pueden cambiar los nombres de los bloques y se pueden usar distintos
colores (Format - Foreground Color). También se pueden rotar blogues (Format
> Flip block, Rotate block), etc.

Ejemplo 1. Construccion de un modelo sencillo

La siguiente figura muestra la construccion de un modelo sencillo que nos permite la
simulacion de la respuesta indicial (al escalon) del sistema en tiempo continuo de
1

segundo orden H(s) = —5————.
s +05s+1

La seflal de excitacion Step la hemos arrastrado desde la libreria Sources, el
visualizador Scope desde la libreria Sinks y el sistema en tiempo continuo Transfer
Fcn desde la libreria Continuous.

Puesto que los pardametros de nuestro sistema continuo son diferentes a los que vienen
por defecto en la libreria de SIMULINK, hemos hecho doble clic en el blogque
Transfer Fcn de nuestra ventana para editar dicho bloque con nuestro numerador y
denominador particulares.

Para iniciar la ejecucion del modelo basta con clicar en el icono * o seleccionar
Simulation - Start. Para cambiar los parametros de simulacion (tiempo final,
muestreo, etc.) seleccionar Simulation - Configuration Parameters.. (0 bien
Simulation - Simulation Parameters.. Segun la version).
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Para ver el resultado de la simulacion clicar sobre el bloque Scope a fin de abrirlo y, una
vez en él, clicar en el icono b para realizar un autoescalado de los ejes.
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Fig. 3. Construccion y simulacién de modelos

2.3 Parametros de simulacion y bloque Scope

Parametros de simulacion: En la v6, los parametros de la simulacion se pueden
modificar desde la barra de menu con Simulation - Simulation parameters. ...

<) Simulation Parameters: untitled

Salver

Workspacel.-"D| Diagnostics| Advanced| HeaI-TimeW’orkshop|

Simulation time:
Start time: | 0.0 Stop time: | 10.0

Solver options

Type: |Variable-step j |0de45 [Dormand-Prince] j

Max step size: | auto Relative tolerance: | 1e-3
Min step size: auto Abszolute tolerance: | auto
Initial step size: | auto

Output options

Fiefine output j Refine factor: |1

QK | Eancel| Help | |

Fig. 4. Parametros de la simulacién (matlab v6)
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En la v7, los pardmetros de la simulacion se pueden modificar desde la barra de menu
con Simulation - Configuration parameters.. ..

E] Configuration Parameters: untitied /Configuration il
Select —Simulation time
- Sohver Stantime:lﬁ Stop time:|1D.D
- Data ImporyExport
- Cptimization —Solver options
E-Diagnostics : :
é----SampIe Time Twpe: I‘v’anable—step J Salver: I odeds (Dormand-Prince) J
Data Validity e step size: Iauto Felative tolerance: |1 e-3
~Type Conversion hin step size: Iauto Absolute tolerance:lauto
i Connectivity Initial step size: fauta
& Cormpatibility ) : -
! Model Referencing Zero crossing cuntrol.l Use local settings J
- Hardware Implement... [~ Automatically handle data transfers between tasks

--hModel Referencing
=-Real-Time Waorkshop
é----CDmments MNurnber of consecutive min step size violations aIIDwed:I'I

—Sobver disgnostic contrals

- Bymhoals Consecutive zero crossings relative tolerance: |1D*128*eps
-Custom Cod . )
usinm Lode MNumber of consecutive zero crassings allowed: |1DDD
..... Debug
----- Interface

10]:8 I Cancel | Help Apply

Fig. 5. Parametros de la simulacién (matlab v7)

Run: Para iniciar la simulacion basta con clicar en el icono * o seleccionar
Simulation > Start en la ventana del modelo (ver Ejemplo 1).

Funcion sim: También es posible ejecutar un modelo Simulink desde la ventana de
comandos o desde un fichero M. La instruccion es sim. En nuestro ejemplo:

>>sim("untitled”)

Warning: Using a default value of 0.2 for maximum step size. The
simulation step size will be equal to or less than this value.
You can disable this diagnostic by setting “Automatic solver
parameter selection® diagnostic to "none® in the Diagnostics page
of the configuration parameters dialog.

Interaccion con el workspace de MATLAB: Desde un modelo SIMULINK, es posible
usar funciones *.m, *_mat y variables del workspace de MATLAB. Los bloques
relacionados son los bloques From File, From Workspace (en la libreria Sources), To
File, To WorkSpace (en la libreria Sinks) y MATLAB Fcn (en la libreria Functions &
Tables).

También es posible poner nombres de variables del workspace dentro del modelo
Simulink. Por ejemplo:

ETSETB. MATLAB. Fundamentos y/o Aplicaciones. Curso 11/12b 5
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Fig. 6. Modelo Simulink con variables del workspace (ay TFin)

Antes de ejecutar el modelo, estas variables deben tener asignado un valor:

>>a=0.5;TFin=10;
>>sim(Tuntitled™)

Model Explorer: Esta utilidad se abre al clicar en el icono B ge |a ventana de modelo.
En concreto, el objeto Base Workspace contiene las variables a las que pueden acceder
todos los modelos Simulink.

B2 Model Explorer =0l x]
File Edit Wew Tools Add Help
DS smax[BH=%Hf o0 @n 45|z A
“Search:lbyBlockType jType:lS—Fun:tion j Search ‘
Model Hierarchy Contents of: Base Workspace Base Workspace
é..@S'mulink Foot | Name |Value | DataType The base (MATLABE) workspace contains variahles that are
: ] H = 05 wisible to all Simulink models. These variables can be usedto
P ) arameterize certain model, block and signal parameters.
- Bhundtied H ScopeData <1x1 struct> k gnale
H Tiin 10
B tout <h3x1 double>
« | 2]
Custornize Contents
--|7 Current Properties
--|_ All Praperties
-7 Fixed-Point Properties
al | B
<| | _.I Contents |§earch Results I Eevert Help Apply
4

Fig. 7. Model Explorer

Bloque Scope: Para visualizar el resultado de una simulacion hay que clicar en el
bloque Scope a fin de abrir la ventana de visualizacion. EIl autoescalado se consigue
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clicando en # . Para hacer un zoom, clicar en £ Los iconos 2 y 2 permiten hacer
un zoom a lo largo del eje x o del eje y respectivamente.

Si queremos poner un titulo, se puede clicar con el botén derecho sobre la
representacion a fin de abrir un menu de contexto y, en él, seleccionar la opcion Axes
properties...

=10l x|
sl opL AREE B A%

al

} 'Scope’ properties: Resp - 0| x|
-min: ' ‘r’-max:l1_5

Title (% <SignalLabel=' replaced by signal name):

IRespuesta indicial

0K Cancel | Apply |

Fig. 8. Titulos en el Scope

Los parametros del Scope se pueden modificar clicando en E'. Por defecto, el Scope
representa solo las dltimas 5000 muestras. Si nuestra simulacion tiene mas de 5000
muestras y las queremos ver todas hay que deseleccionar la opciéon Limit data
points to last: de laficha Data history (ver Fig. 9).

También es posible guardar las variables de la simulacién en el workspace desde la
ventana del Scope:

CEX

<)} 'Scope’ parameters E”§| rg|

v

General | Drata history | Tip: try right clicking on axes

[w Limit data points to last: |5UUD

[w Save data to workspace

Y ariable name: | ScopeData

Farmat: |Stlucture with time: j

Aaray

kK ‘ Eancel| Help ‘ Apply ‘

Fig. 9. Como pasar datos al workspace desde el bloque Scope

La opcién Save data to workspace permite guardar en el workspace los valores
representados en el Scope. Hay tres formatos posibles: Structure with time,
Structure Y Array.

Formato Structure with time: Una vez realizada la simulacion en Simulink, si el
formato elegido es Structure with Time, podemos comprobar que en el workspace de
Matlab aparecen dos nuevas variables

ETSETB. MATLAB. Fundamentos y/o Aplicaciones. Curso 11/12b 7



Tema 5. Simulink

<) Workspace O] x|
File Edit Wew Graphics Debug Desktop Window  Help L
& 5 m & | L | - Stacg:l Elasell

MName £ |Va|ue |Class | |
[€]ScopeData <1x1 struct> struct

M tout <53x1 double>  double

Fig. 10. Formato Struct with time en el workspace de Matlab

La variable ScopeData €S una estructura (struct array). Para ver su contenido, basta
con hacer:

>> ScopeData
ScopeData =
time: [53x1 double]
signals: [1x1 struct]
blockName: "untitled/Scope*

"time", "signals” Yy "blockName" son los tres campos (fields) que componen la
estructura (struct) ScopebData. Vemos que el campo "signals” €S, a su vez, otra
estructura.

Funciones fieldnames, isfield, getfield: Es posible consultar qué campos tiene
ScopeData con ayuda de fieldnames (esta funcion guarda el resultado en un cell
array)

>> nombres=fieldnames(ScopeData)
nombres =

“time*

"signals”

"blockName*®

También se puede ver si un determinado campo forma parte de una estructura:
isfield(ScopeData, “timeT).

Hay dos maneras de acceder al contenido de los campos. Una es mediante “puntos” y la
otra mediante la funcién getfield:

>> ScopeData.signals
ans =
values: [53x1 double]
dimensions: 1
label: ="
title: "Respuesta indicial”
plotStyle: 0O

>> ScopeData.signals.dimensions
ans =
1

>> y=getfield(ScopeData, "signals*®)

y_
values: [53x1 double]

ETSETB. MATLAB. Fundamentos y/o Aplicaciones. Curso 11/12b 8



Tema 5. Simulink

dimensions: 1

label: ="

title: "Respuesta indicial”
plotStyle: O

15

Asi, al representar los datos, podemos ver que las
instrucciones son equivalentes:

yl=getfield(ScopeData, "signals”, "values™);
y2=ScopeData.signhals.values; 05
plot(tout,yl,tout,y2,"--")

Formato Array: En el caso de haber escogido el formato Array, es posible acceder
directamente a dichas variables:

>> size(ScopeData)

ans =
53 2
>> size(tout)
ans =
53 1

En concreto, las dos siguientes instrucciones hacen lo mismo:

>> plot(tout,ScopeData(:,2))
>> plot(ScopeData(:,1),ScopeData(:,2))

Otra forma de analizar las variables es a travées de la ventana de workspace y del editor
de variables:

<) Workspace FEX
File Edit Yiew Web Window Help
= & Stack:
HName Size Eytes|Class
HH Scopelata S3ME 5§45 | double array
HH tout 53x1 424 | double array
Ready
=} Array Editor: ScopeData =) hrray Editor: tout E‘@l@l
Eile Edit Yiew ‘Web Window Help File Edit Yiew ‘Web Window Help
Murneric format: [shortG v | Gize: [53 by [2 x| Mumeric farmat [shotG | | Gize: [53 by [1 x|
1 2 =] i =
1 0 0 1 0
2 0.2 0 2 0.2
3 0.4 i 3 0.4
4 0.5 0 a 0.6 m
5 0.8 0 5 0.8
5 1 0 & 1
7 1 i 7 1
3 1| 1.4619e-023 8 1
k) 1.2 0.019286 a 1.2
10 1.4 0.073343 10 1.4
11 1.6 0.153853 11 1.6
12 1.8 0.26639 12 1.8
13 2 0.39285 13 2
14 z.2 0.52934] 14 2.2 |
15 ?'q DS?US = Array Editor: ScopeData  Array Editor: tout 17
Ready Ready

Fig. 11. Acceso a los resultados de la simulacién (formato array)
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Formato Structure: Si en el Scope se selecciona el formato Structure, en el Workspace
aparecen las variables ScopeData Yy tout, pero la diferencia con el formato anterior
(Structure with time) es que el campo time de ScopeData ahora esta vacio.

2.4 Subsistemas y mascaras

Creacion de subsistemas: Es posible agrupar diversos bloques para crear subsistemas.
Para ello basta con seleccionar con el raton todos los bloques de interés. (Nota: el
bloque Gain lo hemos arrastrado desde la libreria Math Operations 0 Math, segln la
version)

=1 untitled *

Flle Edit Yiew Simulation Format Tools Help

DeE&| & B L] 3 10.0 Mormal | Ee @& BRE®E L

Tl
5240 551 -

Step Transfer Fen Zain Scope

Ready 100%; odeds

Fig. 12. Seleccién de bloques...

Una vez seleccionados todos los blogues que formaran el subsistema, ir a Edit >
Create Subsystem:

=1 untitled =

File Edit Yiew 3Simulation Format Tools Help

hedE # B8 =2 » 5 fioo [Nomd | DB Ew REEG®

Step Scope
Subsystam

Reeady 100%s oded5

Fig. 13. ...para crear un subsistema

Notar que automaticamente se crean, rotulan y numeran los puertos de entrada y salida
del submodelo y que, al hacer doble clic sobre el bloque subsistema, se abre una nueva
ventana de modelo que lo contiene:

=1 untit led/Subsystem * E| E|E|

Ele Edit W¥iew Simulation Format Tools Help

bzES 4

1
-— 1
®_b 5240 S5t b 1)

In1 . Outt
Transfer Fen Fain

F100%: odedS

Fig. 14. Ventana del subsistema
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Mascaras: Una vez creado un subsistema es posible personalizarlo. El editor de
mascaras que se abre al hacer Edit > Mask Subsystem.. permite personalizar el
icono del subsistema, poner unos comentarios de ayuda e introducir, en su caso
(normalmente en Funciones S), los valores de los parametros necesarios.

Por ejemplo, en la v7, poner como Drawing commands el siguiente comando:
image(imread("b747.jpg")), tiene como resultado:

e e m
Iean | Parameter Ilnmahzatmnl D i uI

gtion  Format  Tools  Help

rleon options Drawing command

Frame image {imread ("b747.9pg")) K, ) » 10.0 Normal - B RmEmE 3
[visivle =]

Transparency

IOpaque LI

Rotation E—.

IF\XEE' LI Step

Units

_IAulnsca\a j

rExamples of drawing
CDmmandlpnrt_label {1label specific ports) LI

Lol
Syntax  port_label(output', 1, %y’ e =

Unmask oK Cancel Help Apply

Fig. 15. Méascaras
Una vez creada la mascara, ésta se puede modificar haciendo Edit > Edit Mask. ...

2.5 Funciones S

Las funciones S son bloques SIMULINK programables por el usuario y que sirven para
describir modelos dindmicos complicados (parametros variantes con el tiempo, sistemas
no lineales, con diferentes periodos de muestreo, etc.).

La comunicacion con el exterior (hardware-in-the-loop) también se realiza con
funciones S. En este dltimo caso las funciones S estan escritas en C (contienen los
comandos para comunicacion con las tarjetas de adquisicio de datos y DSPs) y han de
ser compiladas y lincadas con la utilidad mex de Matlab.

Funciones S para sistemas dinamicos: Para la simulacion de sistemas dindmicos,
existen unos ficheros plantilla (sistemas continuos csfunc.m, sistemas discretos
dsfunc.m y caso general sfuntmpl.m) cuyo proposito es ser copiados en el directorio
de trabajo y particularizados con las instrucciones y parametros del usuario.

>> which csfunc.m
C:\Archivos de programa\MATLAB704\toolbox\simulink\blocks\csfunc.m

Estos ficheros estan estructurados en una serie de rutinas bésicas que SIMULINK
ejecuta de manera secuencial:

Inicializacion (mdlInitializeSizes), flag=0,

calculo de la derivada en sistemas continuos (ndIDerivatives), flag=1,
calculo de la diferencia finita en sistemas discretos (nd1Update), flag=2,
calculo de la salida del sistema (ndl10utputs), flag=3, y

tareas de terminacion (mdITerminate), flag=9.

* & O o o
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Notar que esta estructura lo que hace es simular (muestra a muestra) las ecuaciones de
estado del sistema. Primero, simula la ecuacion de estado propiamente dicha
(mdIDerivatives), X=Ax+Bu, y, después, la ecuacién de salida (mdlOutputs),
y =Cx+Du. En el caso de sistemas discretos en el tiempo la ecuacion de estado es

una ecuacion en diferencias (mdlUpdate) es x[n+1] = Ax[n]+ Bu[n].

Funcion csfunc: El contenido del modelo de muestra csfunc.m es el siguiente. Notar
que se trata de un sistema de dos estados (la matriz A es 2x2), dos entradas (la matriz B
tiene dos columnas) y dos salidas (la matriz C tiene dos filas).

>> type csfunc

function [sys,x0,str,ts] = csfunc(t,x,u,flag)

%CSFUNC An example M-file S-function for defining a continuous system.
% Example M-file S-function implementing continuous equations:

% X" = AX + Bu

% y =Cx + Du

%  See sfuntmpl.m for a general S-function template.

%  See also SFUNTMPL.

%  Copyright 1990-2002 The MathWorks, Inc.
%  $Revision: 1.9 $

A=[-0.09 -0.01
1

01;
B=[ 1 -7
0 -2];
c=[ O 2
1 -51;
D=[-3 0
1 01;

switch flag,
%6%%%6%6%6%6%6%6%6%6%6%6%6%6%%%
% Initialization %
%6%%%6%%6%6%6%6%6%6%6%6%6%6%6%6%
case 0,
[sys,x0,str,ts]=mdlInitializeSizes(A,B,C,D);
%6%6%6%6%6%6%6%6%6%6%6%%%%
% Derivatives %
%6%%6%6%6%6%6%6%6%6%6%6%6%%
case 1,
sys=mdIDerivatives(t,x,u,A,B,C,D);
%6%%%6%%6%6%%6%6%
% Outputs %
%6%%%6%6%6%6%6%%%
case 3,
sys=mdlOutputs(t,x,u,A,B,C,D);
%6%%%6%6%6%6%6%6%6%6%6%6%6%6%6%6%6%
% Unhandled flags %
%6%6%6%6%6%6%6%6%6%6%%6%6%6%6%6%%6%
case { 2, 4, 9 },
sys = [1;
%6%%%%6%6%6%6%6%6%6%6%6%6%6%6%6%%6%
% Unexpected flags %
%6%%%%6%%6%6%6%6%6%6%6%6%6%6%6%6%6%
otherwise
error([“Unhandled flag = *,num2str(flag)]);
end
% end csfunc

%

0
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Tema 5. Simulink

% mdlInitializeSizes
% Return the sizes, initial conditions, and sample times for the S-function.

%
function [sys,x0,str,ts]=mdlInitializeSizes(A,B,C,D)
sizes = simsizes;

sizes.NumContStates = 2;
sizes.NumDiscStates = 0;
sizes._NumOutputs = 2;
sizes.Numlnputs = 2;
sizes.DirFeedthrough = 1;
sizes_.NumSampleTimes = 1;

sys = simsizes(sizes);
X0 = zeros(2,1);

str = [1;

ts = [0 0];

% end mdlInitializeSizes
%

0fy;

% mdlDerivatives
% Return the derivatives for the continuous states.

%

function sys=mdlDerivatives(t,x,u,A,B,C,D)
sys = A*X + B*u;

% end mdIDerivatives

%

% mdlOutputs

% Return the block outputs.
7
%

function sys=mdlOutputs(t,x,u,A,B,C,D)
sys = C*x + D*u;

% end mdlOutputs

Para simular una funcién S hay que arrastrar el bloque correspondiente a nuestra
ventana de modelos. EI blogue S-Function esta en la libreria Simulik > User-
Defined Functions. Hacer doble clic para editar el bloque y poner “S-function name”
igual a “csfunc”.

i1 Function Block Parameters: S-Function

E! untitled? ™ EI@I@

File Edit Wiew Simulation Format  Tools |Jzer-definable block. Blocks may be written it C, M [level-1], Fortran, and Ada and
gt conform to SHunction standards. The vaniables t, «. u. and flag are automatically
pazzed to the S-function by Simulink, Additional parameters may be specified in the
Ol = Ly “S-function pararieters' figld. Build process names of addiional madules may be

H % % specified in the "S-function modules' figld.

S-Function

Help

Parameters
system S+function name: |[&: (M= |
S-Function S-function paramelers:l

|
S-function modules: |" |

F100%

| ok H Cancel ” Heln ] pply

Fig. 16. Edicién de una Funcion-S

Acabar de construir el modelo con una excitacién (seno) y un Scope. Simular. Notar
que da error puesto que estamos intentando excitar con una Unica sefial un sistema que
tiene dos entradas:
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B(=1Ed

Wiew  Font Size

Message
" BElack error
@ Block error

Source Reported by Sutmmary

Sine e |Simulink Errarin partwidths or dimensions. Output port 1 of 'untitied? ...
S-Function  Simulink Errarin portwidths or dimensions. Input port 1 of untitled1/...

| & untitled1/Sine Wave

elements.

il

Errarin portwidths or dimensions. Output port 1 of 'untitled1/Sine Wawe' is a one dimensional vectar with 1

21 untitledd *

hed& & & = 3 o |

e Edt View Simulstion Format Tools Help . [ Open ][ Help “ Close ]

Fll

Sine Wave S-Function Scope

0% odeds

Fig. 17. Error debido a las dimensiones

Para solucionarlo, arrastrar un bloque Demux y volver a simular. El resultado ahora es:

=1 untitled1 *

Eile Edit Wiew Simulation Formatb  Tools  Help

b =ES

L] 4 100 Momal =

Py

Sine Wave

Ready 100%

O

S-Function Scope

odeds

Fig. 18. Simulacion de un sistema con 2 entradas y 2 salidas

Debugger: Simulink también tiene su propio debugger. Se abre al clicar en el icono
® . Si hubiéramos ejecutado el debugger antes de simular el modelo de la Fig. 17, ya
hubiéramos visto que habia un conflicto con las dimensiones:

= ) simulink Debugger: untitled - |E| |i|
B b 7% 0| > 11w | ooz | 5 0 S | g
R
BreakPoints | Simulation Loop | ouputs | sorted List | status |
- BreakiDisplay points Warning: 'Elock reduction optimization' is enabled for this model. E;I
Elocks |¢D-I£ To be able to execute all non-virtual blocks consider disabling the
In <a ki s —— i de programatMATLARYRZ006a% toolboxt 5]

P s rror using ==- sldebug
<’ —-» Error in port widths or dimensions.

N, |-—® Error in port widchs or dimensions.
Remaove selected point B

put port 1 of 'untitled;
it port 1 of 'untitled/:

[~ Zero crossings
[~ Step size limited
" Solver Errar
[~ NaN values

r Break on conditions

thArchivos de programa)\MATLABVRZO06a) to

Error in ==
sldebug (name)

hy state .
e
% Please fix the above errors before debugging the model.

e

Break attime

=
l | o

ETSETB. MATLAB.

Fig. 19. Debugger de Simulink
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3. Stateflow

Inicio: Para abrir el STATEFLOW hay que abrir la libreria del SIMULINK vy, desde
alli, arrastrar el bloque Chart a una ventana de nuevo modelo, para, a continuacion,
abrir el editor de maquinas de estado haciendo doble clic en Chart.

[ simulink Library Browser

File Edit Wew Help =] untitled *

File Edt WYiew Simulation Format Tools Help

= ] Find
D & 4 o | D EES S REL@| > = N =]

Chart: Stateflow diagram

B D3P Blockset ~
| Developer's Kit For TI DSP % Chart o~
El Dials & Gauges Blockset

| Fixed-Point Blockset
B Fuezy Logic Toolbox ) Stateflow {chart) untitlad/Chart =
B MPC Blocks
B Motorala DSP Blockset T a8 o WHAO W
| NCD Elockset

B Neural Network Blockset
El Power System Blockset
El Real-Time Windows Target
B Real-Time Warkshop

il Report Generator

W 5-function demos

+- Wl simulink Extras

W Stateflow

W System 1D Elacks

W virtual Realicy Toolbox

B xPC Target

5 F -

*
1

& -

odeds

¥

¢ fre®

+- [

¥

Ready

Ready

Fig. 20. Inicio de Stateflow

Componentes: Para crear la maquina de estados hay que arrastrar los componentes que
se encuentran en la parte lateral de esta Gltima ventana: Estados , Histdrico @l

Transicion por defecto y Punto de conexidn/decision «®<l. Las versiones mas
recientes incluyen Tabla de verdad , Funcion y Funcion Matlab .

Las transiciones entre estados se crean arrastrando el raton entre blogues y, para
editarlas, se clica en ellas y se escribe sobre el interrogante que aparece.

Ejemplo 2. Encendido/apagado

Suponer que se quieren simular los dos estados de un dispositivo (encendido y
apagado). El dispositivo se enciende cuando la variable externa “hora” es mayor que 12
y se apaga cuando es menor o igual que 12. De entrada esta apagado.

En primer lugar se arrastran los dos estados y se edita su nombre: “apagado” y

“encendido”. Indicar que el estado “apagado” es el estado por defecto insertando sobre
él una transicion por defecto.
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Las transiciones entre los dos estados se trazan con ayuda del raton y, para editarlas, se
clica sobre ellas y se escribe sobre el signo “?”. Las condiciones booleanas, como es el
caso del ejemplo, se introducen entre corchetes [ ], mientras que las acciones a realizar
durante una transicion, si las hubiera, se indican entre llaves { }.

<) Stateflow (chart) untitled/Chart * Explorer
Eile Edit gimulstion Wiew Tools Add Help
T ==& B e ERHQ B

g <) | Exploring - untitled/Chart
Eile  Edit - Tools Add Help
ﬁ hora=13] [Object Hierarchy [Comtents of charty untitlediChart
z/ + - =flib Name Scope  Trigger Type Size Min Max Initval
— - untitled [+] Local Real (double) a
encenu:lo 7‘-E(J:h:na ado Local
LD o Input from Simulink
=) G Output to Simulink
Termporary
Congstant
L] I — ]
Roady [ levents {0y data{} targets (0} 1 [1:1]

Fig. 21. Construccién de un modelo Stateflow (matlab v6)

Para indicar que la variable hora es externa (vendra de SIMULINK), hay que abrir el

explorador de modelos (clicar en | @, 0 bien seleccionar View > Model Explorer).
En el explorador, seleccionar Add - Data Yy ajustar los siguientes parametros:
Name=hora, Scope=Input from Simulink (0 Input, segun la version). Asi, en el
modelo SIMULINK, en el blogue Chart aparecera la entrada hora.

Notar que el Model Explorer tiene muchas opciones disponibles, como por ejemplo, el
Model Advisor. Se recomienda echar un vistazo a todas las opciones del mena y la
barra de herramientas.

& Model Explorer -3 il
Fle Edit View Tools Add Help
[Ce(tmaxEmc%iZ sodnon+k|3raza
JJEearch |byEInckType j Type |Chan j Search ‘
Miodel Hierarchy Caontents of. untitled/Chart Data hora
& Simulink Foot | Name | Scape | LabelSting | Part|| General I Yalue Aftributes | Description |
b Base wark
E\ ;u::ilzd*m Shace =) apagado apagado Name Ihura
1 Model Workspace Eaencend\do encendida Parent: (chart] untitled/Chart
[+] hora. Input 1

s Configuration (Active 37 P Scope II”F'M j Part I 1 j

&k Code for untitled 53 [hora<t 2] thoraci2] Size:

% Advice for untitled 53 [hors>=12] [hors>=12] Type

-Sapagado Datatype mode:| Builkin | Detatype:[dovble |
~Eencendido Scaling made: | None -
4 ;I I~ Lock outaut scaling egainst changes by the autoscaling too/
Customize Contents
& Current Properties
™ All Properties
- Fixed-Paint Properties
I — ol

M ;I Contents | Search Results Bevert |{ Help Apply

A

Fig. 22. Model explorer en la v7
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Ahora basta con generar en Simulink una variable que oscile de 0 a 24 y excitar el
bloque chart con ella. En el ejemplo “hora” es una sinusoide de amplitud 12,
frecuencia 0.5Hz y offset 12. EI tiempo final de simulacion es 10s y el tiempo de
muestreo es fijo e igual a 0.001.

Para iniciar la simulacion basta con clicar en el boton run (o seleccionar Simulation >
Start) del modelo Simulink. En la pantalla de comandos de Matlab apareceran una
serie de mensajes relacionados con la creacion de la méaquina de estados.

A medida que la simulacion se lleva a cabo, podemos ver cudl de los estados esta
activado cada vez.

=1 untitled

ateflowr (chart) untitlsd/Chart * File Edit Wew Simulation Format Tools Help

Simulation  Wiew Tools A Help D E"" n é Q s @ }

+ =3 S B &S e ERMKO R
; —0

Scope

Signal
Generatar

hora %

Constant Chart

£

Fl100%: FixedStepDiscrete

<) Scope E] E' E'

S8 LRL hEE

25

L]

v (ICED]

Fig. 23. Ejecucion del modelo Stateflow

Acciones durante los estados: Pueden ser de entrada al estado, de salida del estado o a
realizar mientras se esta en el estado. Las acciones se indican mediante las etiquetas
entry:, during:, exit: (0 sus abreviaturas en:, du-...).

Si se quiere ejecutar una funcién de matlab dentro de estos bloques hay que usar la

funcion ml, por ejemplo, en:  a=ml(“sin(x)”) 0 bien en: a=ml (*sin(%F)*,x) Si x €S
una variable local del Stateflow.
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Tema 5. Simulink

El siguiente modelo implementa el producto de dos nimeros:

Fle Edt View Simulation

=10 x|

Format Tools Help

DS EHE| tBR|(es 42 0

) Stateflow (chart) producte/Chart * _ ol x|
Hle Edit Wiew Simulaton Tooks Add Help £
FRHE | {mR|(Es | 2FE ) = [EHsE ERA0 B

=

I
inicial
entry: tmp=num?2

by BEEEF | @

fin sum
en:prod=prod en: prod=prod+num1

@
3
#

4

rest

num en:tmp=tmp-1
: |_> Display
num2
I
: 3|
il100% | [ lodeds | |Reacty
E& Model Explorer - |Elli|
Hle Edit View Tools Add Help
D seaxEN<%7 fo@on 483 waza]
”Search: Iby Block Type j Type: IChan j Search |
Model Hierarchy ;I Contents of: producte/Chart Data prod
ég,?f;um;rkspace |Name |5|:Dpe | L g General I\/"alue Attributes | Description |
& i Model Warkspas = .re.st. re.st.en:tmpdm Name:lprod
: &y Configuration [Ac = ;h'c'al :”C'a! Em[?‘i mil Parent: char) producte fChart
@Code for product (=3 fin inenpro fsr_c Scope:l Output j Paort: I 1 j
i+ % Advice for produ =) sum Sum 8- prac=g Size‘l
] 587 7 B
- B Chart ! '
6 7 7 Type
Eisum oy 2 . :
- Efin oy o Data type mude.l Built-in j Dalatype.l double j
inicial ? ?
gg;a =l 68 [0>=tmp] [0>=tmp] Sealing mode:| None 'I
LI—I _,I_ Local frrmp] ™ Lock output sealing against changes by the autescaling ool
ocal
Customize Contents Input
i-¥ Current Propeties Iriput
7 All Properties Output
(- [ Fixed-Point Properies
KN — 2]
4 I _>| Contents | Search Results | Fevert Help Apply
v
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4. Efectos de animaciéon con Simulink

El siguiente ejemplo muestra como conseguir un efecto de animacion por medio de
funciones Sy las herramientas GUI.

Ejemplo 4. Pelota que bota

En primer lugar, editar el siguiente fichero bota.m. Este fichero sera introducido en un
blogue S-function (de ahi la definicién de argumentos de entrada y salida).

function [sys,x0] = bota(t,x,u,flag)

%

%BOTA Animacié: jo tinc una pilota que bota, bota, bota...
%

global figH bolaH %la H indica que aquestes variables son object handles

if not(isempty(flag)) & flag==0 %inicialitzacio
%
FfigH=Figure("Name*", “"pilota que bota®", "numbertitle®,off");
%
radi=1;phi=linspace(0,2*pi);
bola=radi*exp(J*phi)+j;
bolaH=patch(real (bola), imag(bola),“b");
set(bolaH, "userdata“® ,bola)
axis([-5 5 0 10]),axis("square”)
%
sys=[0 0 0 1 0 0]; %dimensions O-var d’estat l-entrada O-sortides
x0=[]; %condicions inicials no hi ha pg no hi ha [variables d’] estat
%
end

it not(isempty(flag)) & flag==2 %actualitzacio [posicid] bola (posicid: centre=u)
%
if any(get(0, "children®)==FigH)
posic=u;
bola=get(bolaH, "userdata®);
nova_bola=(bola+j*posic);
set(bolaH, "xdata” ,real (nova_bola), "ydata“®, imag(nova_bola), “erase”, “normal ") ;
end
%
%sortida. No torna res
sys=[1;
x0=[1;
drawnow;
end

if not(isempty(flag)) & flag==9 %terminacio
close
end

En este fichero se ha usado la propiedad UserData del objeto patch. La propiedad
UserData (de user-specified data) permite asociar una matriz de datos al objeto patch.
En nuestro caso hemos asociado la matriz bola (que contiene los puntos que forman el
contorno de la pelota y la posicidn de ésta) a fin de poderlo modificar a lo largo de la
simulacion con SIMULINK.

En segundo lugar, creamos un modelo SIMULINK (pilota.mdl) con los siguientes
bloques. Este modelo es el que genera una sefial u con la posicion de la bola en cada
instante de la simulacién.
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i1 pilota
Ele Edit “ew Simulation Format Tools Help
== L] 3 10 Hormal -

52
24270 D5 55+5°2

Step

Transter Fon

S-Funetion

JReady 100% adeS

Fig. 24. Generacién de la excitacion

Los bloques Step, Tranfer Fcn y S-Function contienen los siguientes parametros:

=] Source Block Parameters: Step E| IZ] Function Block Parameters: Transfer Fcn E|
Step Transfer Fen
Output a step, M atrix expression for numerator, vechor expression for
denominator. Output width equals the number of rows in the
Parameters nurnerator. Coefficients are for descending powers of .
Step fime: Parameters
0
|! | MNumerator:
Initial value: |[5A2]x5 |
1
| - | Denominator:
|Fmal walue: | |[.| #0065 6°2] |
a
Abzolute tolerance:
Sample time: |aut0 |
o |
Interpret wector parameters as 1-D
Enable zero crossing detection
gk ] [ Cancel ] [ Help ] [ ak ] [ Cancel ] ’ Help Apply

Fig. 25. Parametros de Step y Transfer Fcn

E! Sink Block Parameters: S-Function

S-Function

User-definable block. Blocks may be written in C, M [level-1], Fortran, and &da and
muzt confarm ba S-function standards. The variables t, &, u, and flag are automatically
pazzed to the S-function by Simulink, Additional parameters may be specified in the
*S-function parameters' field. Build process names of additional modules may be
zpecified in the "S-function modules' field,

Farareters

S-function name:

S-function parameters:l

|
S-function modules: |" |

[ Ok ] ’ Lancel l [ Help Apply

Fig. 26. Parametros de S-Function
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En tercer lugar, ajustar los parametros de simulacion (Simulation - Configuration
Parameters) tal como se indica:

Cl Configuration Parameters: pilota/Configuration g
Select: Simulation time 5
Solval Start time:lEl.El | Stop time: |'| 0o |
Data Import/E=port
D!:uhmlzat_mn Solver options
=) Diagnostics
Sample Time Type:| Fined-step v|SnIver:| ode5 [Darmand-Frince] v|
Data Inh.agnt_l,l Periodic zanple time constraint: Uncanstrained
Conversion : ) i =
Connectivity Fixed-step size [fundamental zample time]: »
Cormpatibility Tasking mode for periodic sample timnes: | At v|
Model Referencing [ Higher priority value indicates higher task priority

Hardware Implementation
todel Referencing
= Real-Time workshop 2

[ T ~

I OK ] ’ Cancel ] [ Help ] Apply

[ Automatically handle data transfers between tasks

Finalmente, abrir el bloque Scope y clicar en el boton de Run. Los resultados de la
simulacion son:

7 pilota que hota
Fle Edt View Insert Jooks Deskiop Window Help

DEEES K RaMs || 08| =0

E)E)5

gB(LLr ARE BA R

Fig. 27. Pelota que bota (efecto de animacion)
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